A Review of Adobe Photoshop CS3

By Paul Levy
Boeing Employees’ Computing Society member

Special Note: This review was completed on June 11™ and due to my error is only
reaching the newsletter now. There are some things mentioned in here that Adobe has
already fixed with updates. My apologies — Steve Johnson

Photoshop CS3 ($649 or $199 upgrade) is part of Adobe’s Creative Suite (along with a
host of other products such as Illustrator). It is Adobe’s flagship bit map editor, and if you
need a professional level editor for fine art photography there is no viable alternative.
Bluntly stated, Photoshop is the industry standard because of its flexibility and
extensibility (it supports a wide range of third-party plug-ins), its support for color
management, and the robustness of its tools.

Photoshop is an evolving effort, and every year and a half or so Adobe publishes a major
update. Given Adobe’s preeminent position in the art and photo editing markets it is safe
to say that its customers have looked forward to new releases with great anticipation.
This edition not only augments and refines existing tools, but includes entirely new
functionalities.

Adobe extended the reach of bit map editing to a more technically oriented group of
users, culminating with the creation of a new, expanded package aimed at engineers and
others with exacting 3-D modeling and animation needs (Photoshop CS3 Extended, $999,
which includes all of the basic Photoshop CS3 features) while retaining the one aimed at
people creating and editing more traditional bit-mapped images (Photoshop CS3). This
latter group subsumes multiple audiences including web-designers, graphics designers
and photographers whose needs often do not overlap.

Even Photoshop CS3 Basic is so big so as to preclude a thoroughgoing discussion on all
aspects. My expertise is limited to photography, and so I will confine this discussion to
those parts of the basic product applicable to photography. Consequently, I will focus on
Adobe Camera Raw, which ships with Photoshop CS3, along with major additions and
improvements impacting photo editing within the main program.

There are additional components to CS3 which will not be discussed here. The most
notable is Bridge, which functions as file browser, asset manager, light table, rudimentary
slide show maker, and more. Bridge is shipped with each of the CS3 components. Bridge
has evolved into a very capable program, and deserves a separate review. A second
intentional omission in this review is Device Central which allows the user to
synchronize artwork with mobile devices.

Lack of Adequate Documentation and Training
New users need to be aware that Photoshop is not the easiest program to learn. In fact,
learning to use Photoshop effectively is an ongoing, multiyear project. You will find the
tools to be both robust and flexible, but they are designed largely for skilled users.



Additionally, beginners will find the verbiage describing tools and functions difficult to
understand, and at times completely incomprehensible. Unfortunately, Adobe gives short
shrift to training new users. The product does not include a printed manual (you must pay
$12 extra for a printed manual!) instead, Adobe chooses to publish its manual on-line.
Adobe could have included comprehensive training videos specifically designed for
Photoshop CS3, but instead they include a one size fits all video providing superficial
coverage for the entire CS3 family. Fortunately there are many third party books and
videos that can effectively train the beginner. Adobe ought to consider including one of
those books as part of the package.

To be fair, Adobe does provide users with significant on-line resources, including videos,
user-to user forums, etc., but these materials are a poor substitute for a printed manual.

Adobe Camera Raw 4
Minimally, a converter must allow you to make global color corrections (called color
temperature and tint) and tone map (gamma correct) the image. Over the years raw
converters have added more and more functionalities and Photoshop CS3’s Camera Raw
4.0 (ACR4) is no exception. The new converter allows myriad functions normally
associated photo editing such as advanced tone controls, sophisticated color correction
capabilities and monochrome conversion options. This converter even has a red-eye
correction tool and a retouching tool for removing dust and other imperfections. The raw
converter is so full-featured that it could easily be marketed as a stand-alone product.
Noted Photoshop expert Jeff Schewe famously considered Photoshop itself to be an ACR
plug-in!

The function of a raw converter is to transform the information recorded by a camera’s
sensors on a memory device into a viewable image (typically TIFF or JPEG). Adobe goes
a step further by allowing you to open your image as a “Smart Object”. In effect, this
allows you to open your image as if it were an adjustment mask! Imagine, you can
“open” an image as a smart object (it really isn’t open — it’s just a metadata
representation) and then apply adjustment layers within Photoshop. Then you can revise
your Camera Raw settings while retaining all of your adjustment layers.

Most camera manufacturers save raw data in proprietary formats, and every new camera
requires a new data set to translate the raw image. Adobe periodically updates its
converter to incorporate the data to convert the latest digital cameras. Adobe has an
excellent track record in timely release of upgrades. For example, as of this writing (June
6, 2007) the Canon 1D MK III has not yet found its way onto retailers shelves, yet Adobe
has already published an upgrade to support this camera.

Last year Adobe bought a company called Pixmantec which published a program called
Raw Shooter. Adobe apparently modeled the new ACR 4.0 raw converter after
Pixmantec’s Raw Shooter Pro. I won’t delve into all the detailed corrections available in
ACRA4, but I would like to discuss the more notable additions.



Photoshop CS3’s Camera Raw has retained its familiar interface for the most part so it
will be fairly intuitive for seasoned Photoshop users. Functionality is accessed through
tabs labeled with icons running across the top and a series of tabs on the right side of the
window. Icons are meaningless pictures, and while the underlying label could have been
determining by allowing the mouse tip lo linger over the icon, I think that this approach is
not user-friendly. The layout is clean and logical. For those of you who do most of your
image corrections in ACR you will find a very welcome addition to be the ability to
switch to a full-screen editing mode. Pressing the F key allows you to toggle the view.

The Basic Tab contains the controls required to adjust color and tone. In ACR3 tonal
corrections were limited to sliders controlling exposure, shadows, brightness and contrast
plus a curves adjustment which allowed refined global adjustments to contrast. ACR4
adds recovery slider (to reconstruct blown highlights and selectively darken the most
luminous areas) and fill light (to lighten the darker areas). This particular slider is my
favorite addition to ACR because it is such a time saver. In the past I would make two
conversions (one for highlights and one for mid-tones and shadows) and then blend them.
Now with the highlight recover feature I can save many steps and end up with a better
image. This feature alone is worth the price of an upgrade. Another addition within the
Basic Tab is a slider control called vibrance which acts to selectively increase the color
saturation of relatively unsaturated colors without clipping more saturated regions. Adobe
claims this feature is especially useful for portraits. I suspect that it works by imposing an
s-curve around the 0 point of the *a and *b color channels where the steepness of the
curve is controlled with the slider.

The Tone Curve tab was revamped with the addition of what Adobe calls a parametric
tone curve. This option allows you to select and adjust the tone curve in four
interdependent user-defined areas labeled highlights, lights, darks and shadows. The
older (and more flexible) curve adjustment is still available as what is now called a Point
tone curve.

The Detail tab contains the familiar correction sliders for noise and sharpening, and is
unchanged from AC3.

Next we come to an entirely new tab labeled HSL/Grayscale. In the past ACR allowed
color correction using RGB controls. This new set of controls allows the user to remap
colors within a predefined range. Adobe has taken the standard color wheel and divided it
into eight arcs labeled reds, oranges yellows, greens aquas, blues, purples and magentas.
For example, you could shift the hue of colors defined by the greens range to be either
more yellow or more aqua. In addition, you may change the saturation and lightness of
that range. Even more interesting is the ability to create truly impressive grayscale
images from color images by tweaking the HSB controls of the underlying image.

The next tab, labeled split-toning, allows the photographer to apply an overlay of color
separately to highlights and shadows. I suspect that it might best be used for producing
quick gray-scale duotones and perhaps mixed lighting conditions where shadow areas
may have a different color temperature than highlights.



The Lens Correction tab and Camera Calibration tabs contain the same adjustments
available in ACR 3.

The final tab is labeled Presets, and allows you to name and save the settings you created
within the other tabs for reuse.

Preferences are accessed by clicking on an icon at the top of the window. Here you can
specify how image settings (exposure, color temperature, curves, etc.) will be saved
(either as a “sidecar” XMP file or in a central database). Preferences also contains two
other important settings. First, you can decide whether to have ACR actually sharpen the
image or simply sharpen for display purposes. I find that ACR’s sharpening is
insufficiently robust and prefer to sharpen in Photoshop using unsharp mask, so I opt to
apply sharpening to preview images only.

At the bottom of the preferences screen you may determine how ACR deals with XMP
files when you create a DNG file. Adobe created DNG format specification several years
ago in hopes that it would be adopted by digital camera manufacturers, thereby replacing
proprietary raw formats. With few exceptions (e.g., Leica, Ricoh and Pentax), that hasn’t
happened. As of this writing DNG’s principal benefit appears to be the packaging of
“sidecar” information into the same file as the raw data, thus making it easier to transfer
files from one computer to another.

The Workflow Options, which are not labeled as such but are accessed by clicking on the
string corresponding to the workflow settings. For example, you might see something like
Adobe RGB; 8 bit; 2336 by 3504 (8.2 MP); 240 ppi. When you open the workflow
options windows you can change your workflow parameters. There is also a checkbox
that enables you to open your image as a smart object. At the bottom right there are
buttons that allow you to open the processed image in Photoshop, save the processing
directions without opening the image, or cancel.

Your opinion of ACR 4 will vary depending on your workflow preferences. For those
who like to use ACR for as much of the correction process as possible, the enhancements
will be welcome. But for those of us who defer image correction to Photoshop itself, the
enhancements are needless duplications, and in many cases inferior to that provided in
Photoshop. For example, Photoshop offers a robust sharpening tool (unsharp mask),
while the one offered in ACR is mediocre. Similarly, why would one choose to make
duotones in ACR with split-tone toning when a much more flexible tool is available
within Photoshop.

There are a few changes that I do not like. Access to the workflow options is too
cumbersome. Depending on the image, [ may want to choose one color space over
another and the new layout makes it more cumbersome to change. Second, it would be
nice to be able to make changes to preferences in one spot. Now you need to open the
preferences dialog and reset sliders to where you want them and then save this as a
preset. For my preferred workflow I would like to be able to turn sharpening off, turn



noise reduction off, and set contrast to linear in one place. While annoying, this criticism
is trivial, so let me end this section on a high note. Adobe’s ACR4 is first-rate. It creates
images with beautifully detailed shadows, and unlike the proprietary converters that come
with many cameras, it allows for recreation of blown channels.

Shortly after ACR 4.0 was released, Adobe released a major, and breath-taking upgrade —
ACR 4.1. Now the basic tab contains a totally new control called Clarity. The purpose of
this control is to provide impact to mid-range colors. Essentially, it mimics high-radius,
low amount sharpening restricted to mid-tones. Unfortunately, Adobe does not document
exactly what the clarity slider controls. Is it the radius of the effect, the amount of
sharpening, the amount of the combined effect, or what?

The old sharpening slider is gone, having been replaced with a much more sophisticated
set of sliders that look a lot like an augmented unsharp mask. The sliders are designed to
control the size of the halos, the amount of sharpening applied, and selective sharpening
of details and protection from sharpening. These controls, not surprisingly, are called
amount, radius, detail and masking. The chatter on the internet, and Adobe’s user forums
seems to indicate that this set of controls is designed to implement the late Bruce Fraser’s
“capture sharpening” within ACR 4.1.

The Main Program
The program itself has a new but still familiar look. It no longer ships with ImageReady
as an included product, but many of ImageReady’s functions have been included in CS3.
The toolbox is streamlined, and the palettes are more customizable. I won’t spend time
here describing the changes in the look and feel of the palettes. Suffice to say that the
workspaces are easier to work with than in previous versions of the program, and the
palettes make more efficient use of the workspace if you are using a single monitor or a
monitor with a 4:3 aspect ratio. Furthermore, CS3 appears to load and execute faster than
previous versions.

There aren’t many new features in CS3, but there are many enhancements and
improvements. Some of them may not be earth-shaking but still quite welcome. One such
improvement is CS3’s support for multiple workspaces. In the past, the user might create
a workspace (the workspace determines which palettes are open and where they are
placed on the screen) and that was nice, but I always found myself modifying the
workspace depending on what I was doing. CS3 now allows multiple user-defined
workspaces. You can easily access them or modify from the click of an icon on the main
screen.

From the perspective of a photographer there are many notable new features or major
overhauls to existing features.

Selections
Before a photographer can change the value of certain pixels he or she must designate
which pixels are to be targeted for alteration. Selection tools are built-in functionalities



enabling the photographer to decide which pixels to alter based on various criteria such as
pixels within a shape, or color. Adobe has invested considerable effort in easing the
creation of selections based on edges in the form of a new selection tool called Quick
Selection. This tool allows you to make a selection by “painting” a portion of the image. |
gather that this tool is similar to editing in quick mask mode (which allows you to make a
selection by painting), with the added feature of finding edges like the magic lasso tool (a
selection tool based on defining and finding edges). It is one of those enhancements that
seem to be more of a convenience feature than new functionality. Anything that eases the
chore of making accurate selections is welcome. Unfortunately, I found this tool too
difficult to control for situations without extremely well-defined edges. Images
components with wispy edges such as hair fared particularly poorly. But when it works it
is a real time saver.

While we’re on the subject of selections, there is a welcome new palette called Refine
Edges found in the Select menu. In previous versions selections could be modified by
accessing a series of commands like smooth, feather, expand, etc. Or better, you might
paint, blur and change contrast to optimize selection edges. In any case, the required tools
were scattered in various places. Now, selection editing tools are collected in one place
making it much more convenient to make and modify masks. The palette contains sliders
for Radius and Feather which serve to soften selection edges making for a more subtle
edge, contrast, which serves to contract the blurred edge, smooth, which allows you to
eliminate jagged selection edges, and Contract/Expand which allows you to
proportionately increase or decrease the original selection size. There is a series of
viewing choices running along the bottom of the palette which are quite helpful in
visualizing how well your selection will function. This palette alone might convince
photographers to upgrade.

Curves
To my way of thinking, the Curves adjustment layer is the most powerful tool available
in Photoshop. But previous versions it had several shortcomings. First, it had no clipping
display, so you needed to use Levels to accurately adjust the black and white clipping
points using visual cues. Second, it had no facility for displaying multiple channel curves
simultaneously. This version of Photoshop remedies those omissions, and it further
improves Curves with the addition of a histogram overlay option. Unfortunately, the
histogram does not reflect changes as you make them in Curves. The curves display also
includes some seemingly superfluous options. For example, it allows you to display a
“baseline” which is simply a static 45° line. It also includes an option for an “intersection
line” which projects lines from the active point onto the x and y coordinates. If there is
some use for this I can’t figure it out. Nevertheless, the improvements in the curves
dialog are most welcome, and the clipping display will be a big time saver.

Smart Filters
A powerful new feature of CS3 is the extension of smart objects to filters -- the ability to
apply non-destructive, editable filters to you image. Photographers have wanted to be
able to sharpen image with an adjustment layer. In the past, filters such as unsharp mask
required you to operate directly on pixels on a layer, and once you accepted the



sharpening parameters you couldn’t go back and change them. Typically, you would
duplicate the layer you were working on, apply the filter to the layer, optionally mask and
adjust the opacity of the duplicated layer and hope that you got the initial settings right or
you would have to start over. Smart objects changes that. Now, most filters in the filter
menu can be applied in a non-destructive form. With CS3 you first convert a layer to a
smart object. You can apply multiple filters to that layer, and alter the stacking order of
the filters within the smart object. Each smart filter in the stack is fully editable but the
smart object itself contains the mask for the entire stack. However, you can overcome this
limitation by creating several smart objects. The reason that this is an issue is because a
standard technique is to create an edge mask to control sharpening, and to invert and
tweak that edge mask to control noise. This workflow would require two smart objects.
Blending modes and opacity are adjustable within each filter in the stack as well and in
conjunction with the smart object. From a practical point of view smart filter
methodology is slow when using multiple smart objects — painfully slow on my very fast,
very well-equipped dual processor machine with a RAID 0 configuration. I presume that
this performance penalty is the result of the very large file sizes created by smart objects.
Adobe needs to allow the application to access more RAM given the large file sizes and
just how memory intensive CS3 is.

Gray-scale Conversion
One might think that a gray scale image is simply a desaturated color image. You could
produce a gray scale image that way, but it would probably be a big disappointment. To
create a suitable image the best method used to be to manipulate the ratio of the red,
green and blue channels so as to emphasize portions of the image to your liking. For
example, you could darken the sky by setting the blue slider to -50%, the green slider to
120% and the red slider to 30%. While this method produces totally satisfactory results, it
is cumbersome for some users. To answer this issue Adobe has created the Black &
White image adjustment dialog (also available as an adjustment layer). This control
provides a much more intuitive interface than the channel mixer because it now allows
you manipulate the contributions of six colors. However, the meaning of the numbers is a
mystery because they don’t add to any particular number, much less100%. I think that the
nicest part of this dialog is an entirely new kind of control where you can alter the
tonality from the image itself. If, for example, there are some flowers in your image
which you wish to emphasize simply click and hold on the flower and the mouse pointer
changes to a slider control on the image itself. You drag to the left to darken and drag to
the right to lighten. This is a fantastic convenience! There are two other features worth
noting here. By clicking on an area of your image the predominant color is highlighted
above the slider control. Second, not only can you create as luminous a gray scale image
here as you could with the channel mixer, this dialog allows you to tint the resulting
“monochrome” much as you might using the Hue/Saturation adjustment layer. The
bottom line on this new adjustment layer: it is a much welcomed time saver, and for
many users, worth the cost of the upgrade!.

For those still wanting to create monochromes the old fashioned way using the channel
mixer, this venerable tool has undergone a minor, but useful addition for the



mathematically impaired: a warning appears if the individual channels sum to more than
100%.

Clone Source Palette
New to CS3 is a palette called the clone source palette. This palette allows you to
designate up to five sample sources for the healing brush or clone stamp tools and to
define how those sources will be used. For example, you may rotate and distort the clone
in those five clone sources. More importantly, it also allows you to visualize the source
and the target prior to the cloning operation. This overlay feature rectifies an issue I have
long had with cloning tools — the inability to precisely see where I was cloning prior to
the operation. I’'m sure you have had the experience of trying to clone an imperfection out
of something like brickwork and not knowing exactly what the alignment would end up
being. Now, cloning becomes simple and precise. No longer do I need to put up with hit
or miss attempts at precise cloning! Another wonderful feature contained within this
palette is the ability to scale.

New Blending Modes
A blending mode is a rule determining how two layers will interact. For example, in the
Lighten blending mode Photoshop would compare the pixel colors on a channel by
channel basis and choose the higher (brighter) channel value. This almost invariably
produced a color shift because the ratio of the color producing channels would change.
Adobe has added two new blending modes to the layers style palette which compares the
lightness of the pixels (not the individual channels) and chooses the lighter of the two
(blending mode: lighter color) or the darker of the two (blending mode: darker color).
These blending modes will not create color shifts. Rather, they will act as on/off switches
to determine wand choose which of the two colors are lighter or darker as the case may
be.

I have not yet tried them, but these new blending modes are potentially useful in dealing
with difficult mixed lighting situations.

Printer Interface
Gone is the old Print With Preview choice in the File menu. Instead, we have an
improved printer interface entitled Print which brings up a color managed preview. It is
wonderful to previsualize how your image will appear when printed. Additionally, the
interface tells you what resolution is being sent to the printer. The changes are subtle, but
the overall impression I get is that it’s easier to print an image. However, I prefer to
preview and make rendering decisions with Soft Proofing and Gamut Warning active in
Photoshop itself rather than in the Print dialog box. That I could adjust contrast and
saturation on the image itself.

On the plus side, the print screen recognizes new printer profiles without restarting
Photoshop.

All is not roses in the CS3 printing interface. In previous Photoshop versions you could
set the printing parameters once and the program would remember those settings until



they were changed. Now, you must reset those parameters each time you print because,
annoyingly, Photoshop CS3 reverts to default parameters, and this leads to some
frustration among experienced CS2 users. Adobe's solution is to reset the custom print
size in page setup before printing each time.

Furthermore, I have spoken to several expert users who report problems in printing exact
sizes on Epson 2200 and Epson 2400 printers.

The best “workaround” is to use a previous Photoshop version for printing. There really
is no excuse for this buggy behavior.

Things I Wanted But Didn’t Get
Invariably, there are features I would like to see in Photoshop that are not yet included.
One such want has to do with soft-proofing. A soft-proof is a computer generated
monitor display mimicking a print made on a certain printer with a particular paper. A
gamut warning is a representation of those colors which will not be accurately
reproduced by a given output device. In CS3 you would choose Proof Setuo from the
View menu and crate a soft proof by choosing the appropriate paper profile and the
desired rendering intent. But to display gamut warning you need to find the Gamut
Warning item on the View menu and enable it. I would like to see an easier way of
displaying out of gamut colors on soft proofs. For example, suppose I have two candidate
papers, A and B and my choice on which to print depends on how many out of gamut
colors I will get. It would be convenient to access the gamut warning from the soft-
proofing screen.

Refine edges is a nice set of tools that allow you to tweak selections, but I think its
usefulness could be augmented if it included an intuitive channels blending facility.
Currently, channels may be manipulated with Calculations and with the Channel Mixer
adjustment. Both are functional, if somewhat arcane and redundant tools. I am not
exactly sure how I might redesign these tools, but I do believe some thought should be
given to this goal.

Also missing is the ability to address lots more memory.

Finally, a comprehensive printed manual should be included.

Final Thoughts
Every year and a half Adobe announces a Photoshop upgrade, and every announcement
after Photoshop 7.0 left me wondering how Adobe could possibly improve on an already
brilliant product. Each iteration raises the bar. First we had 16-bit adjustment layers, and
then we had smart objects. Now we have the extension of smart technology to filters and
improvements in alignment (not discussed here). I think that there are more than
sufficient reasons to upgrade to CS3.

But for the novice user, be warned: CS3 is not easy to learn, and my biggest complaint is
that Adobe neglects inclusion of adequate training material for the beginner. The learning



curve is steep and extends over many years. I recommend the use of a book like Tim
Grey’s Photoshop Workflow (presumably there will be a CS3 version out shortly to ease
the hurdles in learning the program.

Having said all of that let me end with this thought. If you are serious about photo editing
there is no finer product than Photoshop CS3. Photoshop is the sine qua non for serious
photographic editing.

This product is highly recommended with one important reservation. You must be
prepared to adopt some kind of workaround for the printer problems encountered above.
This is extremely unfortunate. Consequently, I would recommend that potential users
download a trial version of the software prior to purchase so they can see whether the
printer problems will be an issue on their systems, and if so, what workarounds are
acceptable.

Paul Levy is a member of the Boeing Employees’ Computing Society and will get to
keep PhotoShopCS3 as a token of appreciation for this review. If you are interested in
reviewing software, e-mail me at review(@becs-wa.com and let me know what software
you would like to review.




